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11. Heat and Material Balance Module 

 
Fig. 1. Heat and Material Balance workbook with BALANCE, IN1 and OUT1 sheets. 

Heat balance calculations are usually carried out when developing new chemical processes 
and improving old ones, because no process can work if too much heat is released or if 
there is a lack of thermal energy to maintain the reaction temperature. This module 
calculates the real or constrained heat balances, with given mass balances as the boundary 
conditions, but not the theoretical balances at equilibrium conditions. 
 
The heat balance application always contains BALANCE, IN1, and OUT1 sheets. A pair of 
IN and OUT sheets is called a Balance area, which may be considered equivalent to a 
control volume. Many balance areas may be inserted, to create a multiple balance area 
workbook. Multiple balance area workbooks are explained in more detail in Section 11.9. 
Multiple balance areas. For the sake of simplicity, only the first balance area (IN1, OUT1) 
will be described in the following chapters. 
 
The basic idea of the heat balance module is that the user specifies the IN1 and OUT1 
species, temperatures and amounts and the Heat Balance module automatically calculates 
the heat and material balances using the BALANCE sheet. The Heat balance module 
updates the calculated results on the BALANCE row at the bottom of the form each time the 
user changes the input data. Please do not modify the BALANCE sheet. 
 
Since the program uses and creates new balance areas according to the names of the 
sheets, it is extremely important that the automatically created sheet names, i.e. the 
BALANCE, INx and OUTx sheets, should not be modified. 
 
You can also add new sheets for other spreadsheet calculations using the Insert Sheet 
and Insert Excel Sheet selections in the menu. The other sheets work very much like MS 
Excel worksheets, for example, you can: 
 
- rename the sheet name by double clicking the sheet tab 
- type formulae into the cells 
- use similar cell references as in Excel 
- use most of the Excel functions 
- link the sheet to the IN1 sheet using normal Excel cell references, for example, for 

converting elemental analysis of the raw material into component amounts. 
- use the heat balance calculation results in the OUT1 sheet as the initial values for 

other spreadsheet calculations. 
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In addition, the Heat Balance menu provides a wide range of Excel type features, such as: 
number, font, alignment and border formatting, defined name settings, and cell protection. 
Because they are not necessarily needed in heat balance calculations, these features are 
not described here in detail. 
 
The new heat balance module offers several ways to calculate heat and material balances: 
 
1. The user types the input and output species, temperatures and amounts into the IN1 

and OUT1 sheets respectively. This is a simple way to calculate heat and material 
balances. 

2. Materials (species) are given as groups of substances, called streams. These 
streams can be the same as the phases, but they can also be a mixture of phases. 

3. The output amounts can be linked with the input amounts with Excel-type cell 
references, or vice versa. 
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11.1. Basic Calculation Procedure 
 
The following procedure will describe the most simple way to calculate Heat Balance: 
 
1. Enter the input substances (raw materials), temperatures and amounts into the IN1 

sheet. It is possible to either type amounts in kmol, kg or Nm3. It is advised to use 
kmol and kg because missing density data may cause inaccuracy with Nm3 units. 

2. Enter the output substances (products), temperatures and amounts into the OUT1 
sheet. Type the amounts in either kmol, kg or Nm3 as preferred. 

3. When feeding additional energy (electricity) to the process, enter the amount into the 
Total column in the last empty row of the IN1 sheet. You can also type for example 
“Extra Heat” in the first column of this row, see Fig. 1. The Database module will 
convert the color of all “inert” text in the first column to green, unless this text is 
identified in the database as a substance. Note that: 

 
1 kWh = 3.6 MJ = 0.8604 Mcal (th). 

 
 However, the Balance module will automatically recalculate the green text when 

changing the units from the menu. If the green text cell contains a formula, it will 
automatically be changed according to the new unit. For example, a change from °C 
to K will add “+ 273.15” to the end of the formula. 

4. If heat loss values are known, then type them into the last empty row of the OUT1 
sheet in the last column (Total). A first estimate of heat losses for an air-cooled 
reactor (natural convection) can easily be calculated using the following formula in 
kcal/h: 

 
Hloss = (6.8 + 0.046 * T2) * (T2 - T1) * A (1) 

 
where: A = Outer surface area of the reactor (m2) 

T2 = Surface temperature of the reactor (°C) 
T1 = Room temperature (°C) 

 
 Please use the Heat Loss module if more accurate heat loss approximations are 

required. 
5. HSC automatically and immediately updates the heat balance on the bottom line as 

soon as changes to any input data are made. 

6. HSC also automatically updates the material amount balances in mol, kg and Nm3 
units. Note that only the mass balance in kg units on the bottom row should be zero; 
the mole or volume balances can easily change in any chemical process. 

7. The element balance can be checked from Element Balance, see Fig. 1. 
8. By selecting Temperature Balance from the Calculate menu or from the Temp. 

Balance button, it is possible to see the estimated temperature of the products when 
the heat balance = 0, see Fig. 1 and Fig. 2. 
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Fig. 2. Temperature of products (adiabatic process). 

9. To insert an empty row in the table, select Row from the Insert menu or by pressing 
the right mouse button and selecting Insert Row from the popup menu. 

10. Rows can be deleted by selecting Row from the Delete menu or pressing the right 
mouse button and selecting Del Row from the popup menu. 

11. You can change the order of the substances by inserting an empty row and using the 
Copy - Paste method to insert the substance in the new row. The Drag and Drop 
method can also be used. However, it is extremely important to Copy and Paste 
the whole row, not only the formula, because of auxiliary data in the hidden 
columns on the right side of the IN1 and OUT1 sheets. 

 Please keep the Copy Mode selection on in the Edit menu when rearranging the 
species, as this will force the program to select the whole row. When formatting the 
columns and cells, turn the Copy Mode selection off in the Edit menu. 

12. Temperature units can be changed by selecting the °C or K from the Tools bar or 
Units menu. 

13. Energy units can be changed by selecting Mcal, MJ, or kWh from the Tools bar or 
Units menu. 

14. If a paper copy is needed, select Print from the File menu. This option will copy all 
the data onto the same print sheet and will also print this sheet on paper if the user 
presses OK. Notice that you can delete this print sheet by activating it and then 
selecting Sheet from the Delete menu. The Print Sheet selection in the File menu 
will print only the active sheet. 

15. To save the sheets, select Save from the File menu. Please save the sheets often 
using different names, because you may wish to make small changes later or to 
return to the original sheet. Saving sheets is important, because the Undo feature is 
not available in HSC Chemistry. 

16. It is possible to take into account the water/steam pressure compensation by moving 
the cursor to an H2O or H2O(g) species and selecting Insert/Pressure correction H2O 
from the menu. This allows user to type pressure in column C, which is otherwise 
non-editable. This is useful when calculating steam processes, for example. 
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11.2. Formatting the Worksheet 
 
The heat balance module offers several Excel-type formatting possibilities. These may be 
selected in the Format menu: 
 
- Number, Font, Font Default, Alignment, Border, Pattern, Object (for graphical 

objects), Sheet, Options 
- Column Width, Row Height 
- Define Names, Refresh Names 
- Protection On, Off, Lock all Cells, Unlock all Cells 
 
The window size may also be changed from the View menu. Normal gives a VGA size 
window, Full Height uses the whole height of the screen, and Full Width fills the whole 
screen. 
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11.3. Specification of Substance Groups (Streams) 
 
HSC Chemistry 8.0 offers the possibility to specify the input and output substances in 
streams. These streams can be made of one or several physical phases or species which 
have the same fixed temperature and elemental composition. Although heat and material 
balance calculations can be made without using streams, division into streams helps 
considerably when changing temperatures and material amounts. Notice that when using 
formulae/links in temperature cells, the temperature cells are not updated unless the 
species are divided into streams. 
 
Some examples of “one-phase streams” are: 
 
1. Air feed. 
2. Process gas output. 
3. Homogenous liquid and solid inputs and outputs. 

 
Some examples of “multi-phase streams” are: 
 
1. Liquid material with solid particles (suspension) as input or output. 
2. Solid feed mixture of the process, made of different substances such as mineral 

concentrate, coal. and sand. 
3. Gas feed with liquid droplets or solid powder. 
 
The species rows in the IN1 and OUT1 sheets are divided into separate groups by special 
stream rows. These rows can be inserted in the sheet using the Stream selection in the 
Insert menu or using the same selection in the popup menu from the right mouse button. 
 
The heat balance module automatically makes the following modifications to the sheet 
when you insert a new stream (group) row in the sheet: 
 
1. Asks for a name for the new group, which you can change later if necessary. 
2. Inserts a new empty row above the selected cell with a light blue pattern. 
3. HSC assumes that all rows under the new group row will belong to the new group 

down to the next group row. 
4. Inserts Excel-type SUM formulae in the new group row for calculating the total 

amount in the group using kmol, kg, and Nm3 units. 
 
Once the insert procedure is ready, you can edit the group row in the following way: 
 
1. The stream name (label) can be edited directly in the cell. 
2. The stream temperature can also be changed directly in the cell and will affect the 

temperature of all the species in this group. 
3. The total material amount of the group can be changed simply by typing a new 

amount in the group row in kmol, kg, or Nm3 units. This amount can be typed directly 
over the SUM formula and the program will automatically change the amounts of the 
species, keeping the overall composition constant. The program will then regenerate 
the original SUM formula after calculating the new amounts. 

4. It is important to note that you are unable to type formulae in the amount and enthalpy 
columns of the stream row, because the SUM formulae must be in the stream row. 
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To change the amounts of species in a stream using kmol, kg, or Nm3 units, simply type the 
new amount in the corresponding cell. The program will automatically update the amounts 
in the other columns, the total amount of the stream, and the total material and heat 
balance as well. 
 
An example of species streams can be seen in Fig. 3. The output species have been 
divided into four streams. In this example the species in each stream exist in the same 
phase. Process Gas is a gaseous mixture phase, Slag is a molten mixture phase, and 
White Metal is a pure molten substance. 
 

 
Fig. 3. The OUT1 sheet of the Heat Balance module. The species have been divided into three 
streams, which are the same as the existing phases. 
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11.4. Formulae in the Cells 
 
Excel-type formulae and cell references can be used, for example, in order to link the input 
and output amounts with each other and to maintain the material balance automatically 
when the input amounts change. The input and output amounts can be linked using two 
main methods: 
 
1. An Excel-type formula can be typed in the kmol column, which expresses the 

dependence of the output mole amount on the input mole amount. For example, if the 
Cu2S in the cell OUT1!C10 contains 93.8 % of copper input then you can type the 
formula  = 0.938*IN1!C7 in cell OUT1!C10, see Fig. 4. 

2. The Heat Balance module automatically calculates the input and output mole 
amounts for elements. The cell names for input amounts are: InAc, InAg, InAl, InAm 
and the equivalent for output elements are called OutAc, OutAg, OutAl, OutAm, etc. 
For balance areas with a higher number (for example the IN2 and OUT2 sheets) the 
corresponding cell names are simply InAc2, InAc3 and OutAc2, OutAc3, etc. These 
names can be used in the formulae. The formula in the previous example can also be 
written: =0.938*(InCu-C12)/2 using these defined names, see Fig. 5. The cells with 
element amounts are not visible to the user. 

 
Please be very careful when using default input and output names simultaneously, because 
it is very easy to end up with circular references. An indication of a circular reference is that 
the heat and material balance, which can be seen on the BALANCE row, changes even 
after a recalculation (Calculate/ReCalc from the menu). By selecting Format/Options from 
the menu and highlighting the Iteration checkbox under the Calculation tab, it is possible 
to iterate circular references automatically. This is, however, not recommended for very 
large worksheets. 
 
In the IN1 and OUT1 sheets, it is recommended to use formulae only in the kmol column 
and not in the other Amount columns. You can also use the formulae in other columns, but 
please be very careful. In the other sheets there are no special limitations for the formulae. 
 

 
Fig. 4. The OUT1 sheet of the Heat Balance module. The copper output has been linked with the 
copper input with a formula and defined name: InCu. 
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11.5. Elemental Compositions 
 
The elemental compositions of species groups may be calculated using the Stream 
Compositions selection in the Calculate menu, see Fig. 5. This procedure calculates the 
elemental compositions of each group, creates new In1-% and Out1-% sheets and prints 
results on these new sheets in mol% and wt% units. 
 
Note that a procedure to convert elemental analysis back to species analysis is not yet 
available in the Heat Balance module. A general solution to this kind of problem is quite 
difficult and in many cases impossible. However, a custom-made solution for an individual 
case is possible with a little effort and normal Excel-type formulae: 
 
1. Create a new sheet using the Sheet selection in the Insert menu, see Fig. 5. 
2. Rename the new sheet by double clicking the tab, for example to “Compositions”. 

Please note that you can use also the Input-% sheet as the starting point when you 
rename it. 

3. Type the elemental and species compositions in the new sheet. 
4. Note that you can insert Formula Weights in this new sheet by selecting the chemical 

formula cells and then selecting Mol Weight from the Insert menu. 
5. Create Excel-type formulae, which convert the elemental analysis of a group to mole 

amounts of species using formula weights of the elements and species. 
6. Type the formulae in the kmol columns of the IN1 sheet, which refer to species 

amounts in the Compositions sheet. 
 

 
Fig. 5. The Out1-% sheet of the Heat Balance module. This sheet shows the elemental compositions 
of the phases, after the Stream Compositions option has been selected from the Calculate menu. 
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11.6. Additional Sheets 
 
The Heat Balance workbook consists at least of the IN1, OUT1 and BALANCE sheets. The 
user may, however, add more sheets to a workbook. These additional sheets may be used, 
for example, to convert the elemental compositions of raw materials to amounts of species, 
which are needed in the IN1 sheet. These sheets can also be used to collect the main 
results from the OUT1 sheet in a summary table. Avoid using the reserved names IN1, 
OUT1, BALANCE and Target as sheet names. 
 
To add sheets, select Insert Sheet from the menu. This will add one sheet in the selected 
location. To rename this new sheet, double click the Tab at the bottom of the form. You can 
also import Excel sheets by selecting Insert Excel Sheet from the menu. This selection 
allows you first to select the file and then the sheet which you want to insert into the active 
Heat Balance workbook. 
 
The example in Fig. 6 shows a FEED sheet, which is used to specify the raw material 
amounts in the IN1 sheet. The user can give the compositions and amounts in column C, 
and this data will then be used to calculate the amounts of species in column F. The 
material amounts in IN1 sheet are given using relevant cell references to column F in the 
FEED sheet. This example can be found in your HSC8\Balance directory under the name 
CUCONV2.bal8. The user can construct the layout of the additional sheets freely. 
 
The “Red Font Shield” property is a useful way of preventing accidental modification of the 
data in the cells. If this property is set using menu selection Format, Red Font Shield then 
only cells with red font can be edited. However, it is recommended to save the work 
regularly using different names, for example, test1.bal8, test2.bal8, test3.bal8, etc. in order 
to recover the original situation after harmful modifications. 
 

 
Fig. 6. Additional sheets can be added to the Heat Balance workbook. 
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11.7. Target Dialog 
 
The user can iterate manually, for example, the fuel amount which is needed to achieve 
zero heat balance by changing the fuel amount until the heat balance is zero. The Target 
sheet offers a faster automatic way to carry out these kinds of iterations. The following 
instructions will explain this procedure in more detail: 
 
1. Select Target Dialog from the menu. This will also automatically create a Target 

sheet, which is similar to previous HSC versions. 
2. Select one cell in row 4 in the Target dialog if not already selected. 
3. Select one cell which will be used as the first variable and select Set variable cell. 

This will add the cell reference of this variable to the Target dialog in column B. You 
can also type the cell references manually in the Target dialog. Note: Please use only 
Stream temperature cells as variables for the temperature iterations, i.e. do not use 
species temperature cells. 

4. Select one cell which will be used as the first variable and select Set target cell. This 
will add the cell reference of this variable to the Target dialog in column B.  

5. Repeat steps 3 and 4 if you want to add more variables and targets. 
6. Set valid Min and Max limits in columns D and E as well as the Target Value in 

column H. You may also type names in columns A and F. 
7. Usually it is also necessary to give estimated initial Test Values in column C for the 

automatic iterations. Iteration ends when the target value (col H) or iteration number 
(col I) is reached. Accuracy can be improved by increasing the number of decimals 
used in columns G and H with the Format Number selection. 

8. Select the rows (> 3) on the Target sheet which you want to iterate and press Iterate 
selected rows or F8. If all rows need to be iterated, simply press Iterate All. 

 
In the following example, shown in Fig. 7, you can select for example row 4 and press F8. 
This will evaluate the copper scrap amount which is needed to maintain the heat balance in 
the given conditions. Row 5 can be used to iterate the iron content of the matte in the same 
conditions and row 6 to achieve a given FeS amount. 
 
Important note: Please use only Stream temperature cells as variables for the temperature 
iterations, i.e. do not use species temperature cells. 
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Fig. 7. The Target dialog specifies the variables and target cell references. 
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11.8. Graphics 
 
Occasionally, it is useful to see the results of a heat balance calculation, for example, in 
graphical format. This can be carried out manually by making step-by-step changes to one 
variable cell and collecting data from cells of interest, for example, in an Excel sheet. 
Sometimes further calculations may be required after every step, which can be specified 
using the Diagram Dialog. The step-by-step procedure is as follows: 
 
1. Select Diagram/Diagram Dialog from the menu. 
2. Select the variable cell and press Set X-cell from the dialog. Select, for example, cell 

C11, see Fig. 6. 
3. Select a cell for the y-axis and press Set Y-cell from the dialog. Select, for example, 

the Heat Balance cell at the bottom right of the form. You may repeat this step and 
collect several cells whose values will be drawn in the diagram. 

4. If other calculations are required between every step, press Target iteration and the 
Target sheet will automatically open. Select the calculation rows that should be 
iterated before the Y-row and press Set Target rows from the menu. The row data 
will now be tranferred to the Diagram dialog into columns 4, 5, etc. 

5. Fill the Diagram Settings as shown in Fig. 8. You must specify the MIN, MAX, and 
STEP values for the X-axis. You can also specify the cell references, labels and units 
manually in this form. 

6. Press Diagram to create the tabular data for the diagram and Diagram once again to 
see the final diagram, Fig. 8. 

7. The diagram can be modified, copied, and printed in the same manner as other 
diagrams in HSC Chemistry.  

8. Show/Toolbar shows the drawing menu and Show/Object Editor shows the object 
editor, which lets you specify the objects manually. 

9. To return to the Heat Balance module, press Exit at the bottom left corner of the 
diagram form. 

 
In the diagram shown in Fig. 8, you can see that roughly 64 kg/h of scrap is needed to 
adjust the heat balance to zero. Note that the units in the diagram are kg/h and kW.
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Fig. 8. Simple heat balance diagram. 

In the following diagram (Fig. 9), the heat balance is automatically calculated before each 
step, which is indicated by the number “4” in the Target row 1 column. This is done by 
pressing the Target iteration button, selecting row 4 on the Target sheet and clicking the 
Set Target rows button. The x-axis now gives the Fe wt-% and the y-axis the cooling scrap 
required. The diagram may then be interpreted as the quantity of cooling scrap required to 
make the heat balance zero, when the Fe wt-% varies from 20% to 25%. 
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Fig. 9. Diagram where the heat balance is automatically iterated to zero before every calculation 
step. 
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11.9. Multiple Balance Areas 
 
Since most processes consist of multiple balance areas, the Balance module enables the 
user to create multiple balance areas. A balance area consists of an INx and an OUTx 
sheet, where x denotes the number of the balance area. These can then be connected to 
each other, creating a realistic simulation of a process. The example file FSF_process.bal8 
contains a highly simplified multibalance model of the Outotec Flash Smelting Furnace 
process. 
 
A new balance area is created by selecting either Insert/Balance Area from the tools 
sheet. This will insert a pair of INx and OUTx sheets in the corresponding position. It is easy 
to delete a balance area by selecting Delete/Balance Area. However, deleting a single 
sheet of a balance area, for example in an INx sheet, is not possible. The balances are all 
automatically collected into the BALANCE sheet so please do not modify this sheet. 
 

 
Fig. 10. A BALANCE sheet where the worksheet consists of 5 balance areas. 

It is recommended to carry out the linking of balance areas with each other after each 
individual balance area is operating properly. Linking may be achieved either manually with 
formulae or automatically with the Copy - Paste Stream combination. Simply place the 
cursor on a stream row in an OUTx sheet, or on a row that belongs to a stream, and select 
Edit/Copy. Then place the cursor on a row in an INx sheet and select Edit/Paste Stream. 
The stream will now be copied here so that the first row of the stream is in the cursor 
position. The kmol column of the pasted stream will consist of links (formulae) to the copied 
stream, so that the material amounts of the streams will remain equal. The other cells are 
directly copied as values. If the stream temperature cell in the copied stream is a formula 
then it will not be copied. In this case it is up to the user to decide how the stream 
temperature for the pasted stream should be calculated. 
 
It is also possible to create return streams, i.e. streams that return to a previous part of the 
process, thus creating loops in the process. When pasting a stream into an already linked 
part, a circular reference might occur. This is the case when links eventually refer back to 
each other, i.e. iterations are needed to calculate the worksheet. Automatic iterations may 
be done by selecting Format/Options from the menu and highlighting the Iteration 
checkbox under the Calculation tab. Please be careful when changing the inputs of a 
worksheet consisting of circular references. For example, if a cell, which is part of a circular 
reference, shows the message #VALUE!, it will not be recovered unless the links in the 
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cells are changed thus breaking the circular reference. Therefore, it is recommended to 
save the worksheet regularly using different names (Test1, Test2, etc.). 

 
Fig. 11. The IN1 sheet (Flash Furnace) of the FSF_process.bal8 example. The stream Flue dust is 
a return stream from the boiler (Copy/Paste stream), thus creating circular references in the 
worksheet. 

Automatically updated defined names (input and output kmol amounts) vary according to 
the balance area. For example, InAl, InC, OutFe for the first balance area will become 
InAl2, InC2, OutFe2 for the second etc. Note that the defined names of the first balance 
area do not have index numbers. 
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Fig. 12. The OUT2 sheet (Converter I), gives the output from the first part of the converter. The 
formula =InCa2*Analysis!L29/100 in cell C5 means that the total Ca is distributed as the percentage 
given in cell L29 on the Analysis sheet. 

Drawing Flowsheets (Flowcharts) 
 
Additional sheets may be used to collect, for example, all the necessary input for the 
process into one sheet. They may also be used to collect calculated process parameters, 
for example the amount of Cu in a stream. Fig. 13 shows the process layout for the Flash 
Smelting Furnace process. 
 
The "Insert, Graphical Object, ..." selection offers the possibility to draw lines, rectangles, 
etc. on the additional sheets. However, it is recommended to draw flowsheets using the 
"Format, Border, ..." and "Format, Pattern, ..." selections because these properties are 
more compatible with Excel. Arrows may be drawn using the "Insert, Graphical Object, 
Arrow" selection. 
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Fig. 13. Process layout and input sheet for the Flash Smelting Furnace process. 

Fig. 14 provides a more detailed analysis of the process. The model is constructed so that 
the inputs are given as species analysis and the outputs are calculated. The elemental 
distributions are also inputs, in other words the user defines the wt-% for the elemental 
distributions into the given species and streams. This is achieved by using the automatically 
defined names, for example InCa and InO2, thus always keeping the elemental balance at 
zero. The model may then be used to balance the heat balances of the process, which 
enables the user to calculate one unknown parameter per balance area. The unknown 
parameters calculated in the FSF_process.bal8 example are indicated by a light blue cell 
background. The calculated parameters may be changed using the Target Dialog option, 
which is described in further detail in Section 11.7. Target Dialog. 
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Fig. 14. Detailed analysis of the input and output streams and the elemental distributions into 
different species. The distributions are given in wt-% (weight percentage). 
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11.10. General Considerations 
 
In the Heat Balance module it is possible to use the new add-in functions provided by HSC 
8.0. The functions should are enabled automatically. Sometimes it is necessary to browse 
the location of the add-in file manually. A more detailed description of the functions 
available may be found in Chapter 30. Excel Add-Ins. It is, however, not recommended to 
use add-in functions for very large worksheets, since a complete recalculation of the 
worksheet is necessary each time a change is made in the worksheet. This is the case only 
when using add-in functions. 
 
Please do not use temperature formulae that are linked to other temperature values within a 
stream, instead link them to the stream temperature cell or any cell in a user sheet. 
Otherwise, the temperatures will be updated only after the next change. Please also note 
that a change in the temperature value is required for the whole stream to be updated 
accordingly. 
 
Simple graphical objects may be inserted by selecting Insert/Graphical Object from the 
menu. The shapes are: Line, Rectangle, Oval, Arc, and Polygon. After inserting, the objects 
may be modified by first selecting the object and then selecting Format/Object from the 
menu. 
 
The Heat Content column (= specific heat) is used to describe the energy which may be 
released when the compound is cooled down from the given temperature to 298.15 K. In 
other words, it contains latent heat (= enthalpies of the possible phase transformations) as 
well as specific heat. The enthalpies given in the Total H column contain the values of the 
Heat Content column as well as the heat of formation reactions. These values are used to 
calculate heat balances. 
 
In molten mixtures such as oxide slags, substances can exist in liquid state at lower 
temperatures than their melting points. In these cases, it is possible to use an (l)-suffix at 
the end of the formulae, see Fig. 1. This will force HSC to use the data of the liquid state for 
species with an (l)-suffix. 
 
The “Red Font Shield” property is sometimes useful if you want to prevent accidental 
changes to cells. You can activate this property by selecting Format Red Font Shield from 
the menu. After this selection you can edit only those cells which contain red font. 
 
If you have carried out a laboratory- or industrial-scale experiment or process calculations 
you usually know: 
 
1. The raw (input) materials and their amounts and temperatures. 
2. The product (output) materials and their amounts, temperatures and analysis. 
3. The input heat and heat losses can first be estimated as zero, if not available. 
 
In order to calculate a heat balance, you must first convert the (elemental) chemical 
analysis of the raw materials and the products into input and output substances (species). 
Sometimes this step is the most difficult, so you may choose to carry out this procedure 
using the HSC Species Converter module, see Chapter 22. Species Converter. When this 
is completed, simply type the input substances (species) into the IN1 Sheet and the output 
substances into the OUT1 sheet. Immediately after that you will see the heat and material 
balance on the bottom line. You can also test the procedure described in Section 11.5. 
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It is important to check the element balance by selecting Calculate/Element Balance, in 
order to avoid incorrect material and heat balances. This can also be used to check the 
validity of the chemical analyses and the other amount measurements of the experiment if 
the user input is based on this data. 
 
When creating a multiple balance area model, selecting Calculate/Total Balance shows an 
overview of all balance areas in one window. This is useful for a quick check where the 
material and/or heat balance are not zero. It also shows the total (or net) material and heat 
balance for all balance areas. It is then easy to see which balance areas produce heat, 
which require heat, and indications of how the heat could be tranferred within the process. 
 
On the basis of the final results, conclusions can be made as to whether extra energy is 
needed or increased insulation is required or if the reactor needs cooling on a large scale. 
The heat losses may also be determined using the HeatLoss module. Combining the two 
modules provides a powerful way of calculating processes. 
 
It is important to note that this is a real heat balance for engineering purposes, which also 
takes into account the kinetic aspects if the user input is based on real experimental data. 
The heat balance, which can be obtained from the equilibrium calculations, is theoretical in 
this respect. It is valid only if the equilibrium is reached in the real process. 
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11.11. Heat Balance Examples 
 
See the examples provided by the HSC package by selecting File/Open from the menu, 
see Fig. 1, and selecting some of the ready-made files in the directory for editing. HSC 8.0 
can read the old HSC 2.0 Heat Balance text files, but it cannot save them in the old format. 
The new HSC 8.0 Heat Balance files save all the sheets and formats, not only the text data. 
 
1. Preliminary check for a heat balance (CUSMELT.bal8 file) 
 For some processes based on reaction equations or equilibrium calculations, the heat 

balance can easily be checked by entering the assumed input and output substances 
as well as their temperatures and amounts, see example CUCONV.bal8 and 
CUSMELT.bal8, Fig. 1. 

 
2. Adiabatic temperature of a flame (BUTANE.bal8 file) 
 In an adiabatic process, heat losses from and heat input to the system are zero, i.e. 

there is no heat exchange with the surroundings through the system boundaries. 
Therefore, the adiabatic temperature equals the highest attainable temperature from 
a flame or a chemical reaction. By typing the raw materials into the IN1 sheet and the 
products into the OUT1 sheet, it is possible to see the adiabatic temperature by 
selecting Temperature Balance from the Calculate menu, Fig. 2, see example 
BUTANE.bal8. 

 
3. Dimensioning of an evaporator (H2O.bal8 file) 
 The evaporator dimensions can be optimized manually by typing the input substances 

into the IN1 sheet and the desired output substances, amounts and temperatures into 
the OUT1 sheet. Once these have been entered, you can start to change the amount 
or temperature of the input vapor (input heat if heated by electricity) manually, in 
order to find the optimum values. See the example of H2O.bal8. 

 
4. Net and gross heat value of coal, fuel oil and natural gas (Coal1-, Coal2-, 

FuelOil1-, FuelOil2-, NatGas1.bal8 files) 
 The Heat balance module makes it possible to calculate the Heat Values (Calorific 

Values) for different fuels. Examples for coal, fuel oil and natural gas are found in the 
example files. Note that the chemical structures of fuel oil and coal are very 
complicated. However, heat values based on elemental analysis will usually give 
sufficiently accurate results for practical applications. 

 
5. Outotec Flash Smelting Furnace process (FSF_process.bal8 file) 
 This highly simplified process case consists of five balance areas linked together. The 

balance areas are: 
 

1) Flash Smelting Furnace 
2) Converter I 
3) Converter II 
4) Boiler 
5) ESP 

 
The process input values are provided in the sheets Process flow and Analysis. By 
pressing F8 or by selecting Iterate All from the Target Dialog, the heat balances are 
calculated. The values calculated are in the sheet Process flow and indicated by a 
light blue cell background. 
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6. Iron production process (Iron_process.bal8 file). 
 The example in this file is a very simplified model of an iron production process 

consisting of three balance areas: 
 

1) Pelletizing 
2) Coking 
3) Reduction 
 

 The process and its most important parameters are shown in the sheet Process 
flow, with a more detailed analysis available in the sheet Analysis. Notice that only 
the material balances are zero and iterated according to what is set in the Target 
sheet (or Target dialog). The heat balances are not iterated and therefore not zero. 


